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Spatial Display

Image Contrast Enhancement
Images that you display may have poor inherent brightness and
contrast.  The Display process in TNTgis can automatically
adjust the brightness and contrast of images, but you can also
design and save specific contrast enhancements using the Ras-
ter Contrast Enhancement window.  This window lets you create
and save contrast look-up tables that translate each input raster
value to an adjusted brightness value.  You can design contrast
tables that change the average brightness value of the display
and that spread the input values over a different range of dis-
play brightness to change the contrast.  For a color composite
raster or an RGB display of three raster objects, contrast and
brightness adjustments for each color component also improve
the overall color and color balance of the display.
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Display of RGB image with no enhancement (left) and with contrast-
enhancement (right) for the red, green, and blue components.

The input histogram is shown vertically along the left edge of
the window and the histogram of the display values is shown
horizontally across the top.  The translation curve graphs the
function used to convert input raster values to display values.
Some enhancement methods allow you to directly manipulate
the shape of the translation curve.

The Settings panel (or equivalent) includes a Method menu
from which you can choose an enhancement method, which
determines the shape of the translation curve. The Input Range
fields show the minimum and maximum values defining the
input range used to create the translation curve.  The Output
Range fields show the minimum and maximum output display
values to be used.  In most cases you should use the full range
of output display values (0 to 255) and adjust brightness and
contrast by varying the input range, contrast method, and (where

allowed) the translation curve.

The input histogram graphic is provided
with dashed lines that allow you to change
the lower and upper input limits by visual
comparison with the shape of the histo-
gram.  Left-click and drag either of these
lines to change its position in the graphic.
The values corresponding to the positions
of these lines are then shown in the Input
Range fields.  You can also enter values
manually in these fields if desired.

For an 8-bit raster component the default
input range is the maximum range allowed
by the raster type (e.g., 0 to 255 for 8-bit
unsigned).  The input data values may only
occupy a portion of that possible range,
resulting in a low-contrast display.  Mov-
ing the input limits to match the actual
range of raster cell values spreads these
values over the entire output display range,
improving brightness and contrast.  If you

reduce the input range further, any input values less than the
lower limit are displayed as black and any values above the
upper limit are displayed as white; truncating the input histo-
gram in this way is perfectly acceptable for many images.

The Raster Contrast Enhancement window is opened using the
Enhance Contrast option on the right mouse-button menu for a
raster layer listing in the Display Manager or View window
sidebar.  The upper part of the window (illustrated below) in-
cludes a graphical representation of the contrast adjustment.
The lower portion of the window has a Settings tabbed panel
(for a single grayscale raster) or Red, Green, and Blue tabbed
panels that allow separate adjustments for the components in a
24-bit color-composite raster or RGB separates display.  Con-
trols on the Region tabbed panel allow you to design the contrast
enhancement using only a portion of the image (see the Tech-
nical Guide entitled Contrast Enhancement for Local Areas).

Raster Contrast Enhancement Window

(continued)

Single
Raster
Display

Color
Display



                                       MicroImages, Inc.   •   TNTgis - Advanced Software for Geospatial Analysis
Voice (402)477-9554  •  FAX (402) 817-0151  •  email  info@microimages.com  •  web  www.microimages.com  •  May 2015

Histogram Options
The Options menu provides several alternative ways to show
the input and display histograms.  The display histogram is
shown by default as a bar graph, with one vertical bar for each
histogram bin and the height of the bar representing the cell
count in that bin (in many cases the bars merge together to
create a solid “fill” for the graph). The Envelope toggle option
changes the display histogram to a simple curve.  The input
histogram is only shown as an envelope.

Output histogram with envelope
off (above) and on (below)

Input histogram with
linear scale (left) and
logarithmic scale (right)

Input Limits expressed as data values
(above) and as percentiles (below)

The Input Limits submenu provides two options for showing
the values in the Input Range fields: as Data Values (actual cell
values) or as Percentiles.  The Input Scale submenu provides
Linear and Logarithmic options for scaling the input histogram.
The Logarithmic option makes it easier to see the occurrence
of low-frequency values in the tails of the histogram.  Linear
and Logarithmic options are also provided on the Output Scale
submenu for the display histogram.

Contrast Methods
As you make adjustments using the Contrast Enhancement
controls, you can press the Refresh icon button on the View
window after any change to see the effect on the displayed
image.  Good brightness and contrast are generally achieved
when the median input value is translated to the median display
brightness and display brightness values are well-distributed
over the entire range.  A number of different contrast enhance-
ment methods are provided to allow you to produce good
brightness and contrast with a variety of different images.  You
should experiment to determine which methods work best for
the types of images you work with.

Linear: In the this method there is a linear relationship be-
tween input and display values.  The translation curve is a straight
line sloping upward to the right (see illustrations on the previ-
ous page). You cannot adjust this line directly in the graphic.  If
the input limits are set at the maximum range, the display histo-
gram is identical to the input histogram and there is no
enhancement.  Restricting the input range produces a transla-
tion line with a lower slope between these narrower limits,
distributing the image values over a wider display range to in-
crease the contrast.  Changing the lower and upper limits by

The Invert toggle button reverses the translation curve so that
low input values are translated to high display brightness and
high input values are converted to low display brightness.  This
option is generally reserved for specialized applications.

different amounts also shifts the mean brightness to higher or
lower display values.

Normalize: The Normalize contrast method adjusts the input
values to approximate a normal frequency distribution with a
symmetrical bell-shaped display histogram covering the full
output range.  The translation curve has a variable shape and
cannot be adjusted directly (see illustration below).  Changing
the upper and lower input limits does not affect the normalized
display histogram unless actual cell values are excluded, and in
most cases excluding a small percentage of high and/or low
values has little affect on the normalized display histogram.

The normalized display histogram graphic is provided with three
dashed vertical control lines that can be used to adjust the shape
of the histogram.  The middle line indicates the median bright-
ness value, for which there are equal numbers of brighter and
darker cells; its output display brightness value is shown in the
Median field at the bottom of the window.  The default position
of the median line is at the midpoint of the output range, which
is 128 for an 8-bit unsigned raster object.  You can drag the
median control line to the left (or enter a lower Median value)
to make the display darker and to the right (or enter a higher
Median value) to
make it brighter.

The two deviation
lines control the dis-
tribution of display
brightness values on
either side of the
median.  By default
these lines are
placed at display
brightness values 50
units below and
above the median
display brightness;
these distances are
shown in the Below
and Above numeric
fields.  Moving the
Above deviation line
farther to the right broadens the distribution of values above
the median, stretching the contrast for the brighter parts of the
image.  Conversely, dragging the Below deviation line to the
left stretches the contrast for the darker portions of the image.
The current Below and Above distances are maintained when
you change the median position of the normalized histogram.
You can quickly restore the median and deviation lines to their
default positions by choosing Reset from the Options menu.

The normalize method works well for many images that have
low inherent contrast.  For images requiring only modest con-
trast enhancement, however, the normalize method may boost
the image contrast too much and produce harsh colors.

Equalize: The Equalize method attempts to produce a flat dis-
play histogram, with equal numbers of cells at each display
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brightness level.  However, with most input images this goal
cannot be achieved because real images have varying numbers
of cells at each brightness value and all input cells with the
same value must be assigned the same output display value.
The equalized display histogram for most images resembles a
broader, flatter version of the normalized histogram (see illus-
tration below).  The translation curve has a variable shape and
cannot be adjusted directly.  The result is little affected by modest
adjustments to the
input range.

Histogram equaliza-
tion greatly
increases the num-
ber of input values
that are displayed at
the low and high
ends of the display
brightness range,
as can be seen by
the crowding of the
display histogram
bars at the left and
right sides of the
histogram.  The re-
sult can be a display
with even greater
contrast than a nor-
malized display.

Exponential:  The Exponential contrast method creates a trans-
lation curve that is an exponential function of the input value.
The function is computed from the lower and upper input lim-
its you set and the magnitude of the exponent used in the
function, which is shown in the Power field.  At the default
Power value of 1.00, the translation curve is a straight line
between the minimum and maximum input values.  You can
change the shape of the translation curve by changing the input
limits and by dragging the translation curve, which changes
the Power value.
Dragging the curve
to the right de-
creases the Power
to values below
1.00, resulting in a
curve that is con-
cave toward the
upper left and
which shifts the
median display
brightness to higher
values.  Dragging
the curve to the left
increases the
Power to values
greater than 1.00,
resulting in a curve
that is convex to-

ward the upper left and which shifts the median display bright-
ness to lower values.  The Exponential method thus lets you
easily change the overall brightness of the image while limiting
the effects to the specific input range you specify.

Logarithmic: The Logarithmic method creates a translation
curve that is a logarithmic function of the input value.  The
translation curve is
not adjustable ex-
cept for setting the
lower and upper
limits.  This method
is most useful for
images with a high
proportion of low
cell values, which
is common in
many images from
imaging radar sys-
tems.  However, an
approximately loga-
rithmic translation
can also be set up
using the Exponen-
tial method, in
which you can ad-
just the Power to
make fine changes to the enhancement.

Hyperbolic Tangent: This method uses the hyperbolic tan-
gent trigonometric function to produce a nonlinear translation
of input values (within the specified range) to display values.
The method provides an adjustable Scale factor (default value
= 1.0) that can be used to adjust the enhancement.  At low
values of the Scale
Factor (less than 1)
the translation
curve is close to lin-
ear.  Increasing the
scale factor flattens
the middle portion
of the translation
curve while steep-
ening either end,
which stretches
contrast in the
middle portion of
the input range at
the expense of low
and high values.  Il-
lustrations of the
effects of this
method are in-
cluded in the
TechGuide entitled Hyperbolic Tangent Contrast Enhancement.

User-Drawn: When you choose the User-Drawn method, it
initially inherits the previous translation curve.  You can then
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freely adjust the
enhancement in
two ways. You can
drag the mouse cur-
sor along the
translation curve to
redraw the curve,
or manually redraw
the display histo-
gram in the same
way.  You can use
this method to se-
lectively stretch
some parts of the
input range while
compressing oth-
ers to fine-tune a
previous enhance-
ment or to create
special effects in
the display.

Saving and Opening Contrast Tables
A contrast table is saved as a subobject of the raster object it
applies to.  You can create multiple contrast tables for the same
raster object for different uses.  For a band in a multispectral
image, for example, you might create a contrast table for
grayscale display of the band by itself, and one or more con-
trast tables for the band when used as a color component in an
RGB separates display.  The File menu in the Raster Contrast
Enhancement window provides options to Save, Save As, and
to Open an existing contrast table.  When you are adjusting
contrast for a color display, you save separate contrast tables
for each of the three color components.

Using Contrast Tables
When you display an image, the Raster Layer Controls win-
dow provides a Contrast menu (on the Object tabbed panel)
for each of the color components in the layer.  This menu lists
each of the contrast tables that have been saved with the raster,
allowing you to choose the table to use for the current session.
Your selection is saved with the other display parameters for
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Method

this raster object so it will
be used by default the
next time the raster is
displayed.  The menu
also lists a number of
automatic contrast meth-
ods (Auto Linear, Auto
Normalize, etc.) that en-
hance the contrast using
default parameters for
the method.  If no con-
trast table has been
saved for the raster, you
can use any of the Auto
Contrast methods to dis-
play it. If you then open
the Raster Contrast Enhancement window, the corresponding
method is automatically set, allowing you to make and save
further refinements.

The Contrast menu for an 8-bit unsigned raster object also
includes the option None, which you can use to display the
raster directly with no translation of the raster values.  This
option is not available for raster data types that can have values
outside the range 0 to 255 (e.g., signed integer, 16- and 32-bit
integer, and floating point) since values in these data ranges
require rescaling to the 0-255 display range.

If no contrast table has been saved with a raster object, and it
has not been displayed previously with the None option, then
one of the auto-contrast enhancement options is automatically
applied.  The method used by default can be set in the Options
window opened from the Display Manager (Options / View
Options).  The Raster tabbed panel in this window includes a
set of menus under the heading Default contrast when none
previously set.  You can
set different auto-contrast
default options for differ-
ent raster data types: 8
bits or less, 16 bits or
more, and hyperspectral.


